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Introduction 

The overall aim of this self-study guide is to enable web publishers to become 
competent users of TerminalFour (T4) Site Manager, to create and update 
content to University standards on the University of Bristol’s public-facing 
website (http://www.bristol.ac.uk). 

It is intended to be used for independent self-paced learning or as a reference 
guide. 

This document can be downloaded from 
www.bristol.ac.uk/style-guides/web/training/t4-training/ 

 

After working through this document you will be able to: 

• add, modify and manage content within existing Sections (pages); 

• add new Sections (pages) and manage the site structure; 

• manage site assets (e.g. images and documents) in the Media Library; 

• format content (including creating links and inserting images) using the built-in 

visual editor TinyMCE. 

• manage the left-hand side navigation menu; 

• approve content for publication. 

 

• Site Manager training and support on the web 

www.bristol.ac.uk/style-guides/web/ 

• University web policies and governance 

www.bristol.ac.uk/style-guides/web/policies/  

• University writing house style guide 

www.bristol.ac.uk/style-guides/writing/house-style/  

 

TERMINAL FOUR Site Manager is the University of Bristol Web Content 

Management System (CMS) for public-facing websites. It is a web-based tool for 

managing and publishing content on the University website. 

It makes it easier than ever for people with no technical knowledge of the web to 

edit and publish web content easily and quickly. 

 

Basic IT literacy (i.e. ability to use a computer, keyboard mouse and web 
browser). 

 

 

This document is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 2.0 UK: England & Wales 
Licence (http://creativecommons.org/licences/by-nc-sa/2.0/uk/). Its “original author” is the University of Bristol which 
should be acknowledged as such in any derivative work. 

© 2017 University of Bristol. All rights reserved. 
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How to use this self-study guide? 

If you are completely new to T4 Site Manager 

Work your way through the guide chapter by chapter from the beginning. 

Do the activities using the training site provided for this purpose (login details are 

available from the Digital Communications Team (web-editor@bristol.ac.uk).  

If you already use T4 Site Manager 

If you are already using Site Manager and need a refresher or a quick reminder 

on how to do something, refer to the table of contents. 

Alternatively, use the task-based checklists below to help you with some 

common tasks. 

I want to… 

…update an existing page    4 Modifying content 

   8 Editing and formatting text in TinyMCE 

…create a new page  2.1 Adding a new Section 

  3 Adding content to a Section 

  8 Editing and formatting text in TinyMCE 

…create a link to a PDF file   7 Adding media to the Media Library 

 8.3 Creating links 

  

mailto:web-editor@bristol.ac.uk
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 1 Getting to know Site Manager 

Objectives In this task you will: 

• learn how to access Site Manager; 

• learn to navigate around the Site Manager interface; 

• gain an understanding of website structure in Site Manager 

• gain an understanding of user rights and roles; 

• gain an understanding of the Site Manager workflow 

Comments The URL to login to Site Manager is t4cms.bris.ac.uk. 

 

 

1.1 Accessing Site Manager 

Site Manager can be accessed on any computer within the University network or 

outside using a modern web browser except Internet Explorer when set to 

display websites in Compatibility View mode. For this reason, we recommend 

you use Google Chrome on University-owned PCs. 

1. Open your preferred web browser and go to t4cms.bris.ac.uk. This takes 

you to the Site Manager logging screen (Figure 1): 

 

Figure 1: Site Manager UoB login screen 

As a University web publisher, it is your responsibility to ensure that the 

information you provide on your website is up-to-date, professional and 

accessible. Also, it must comply with current Data Protection, Freedom of 

Information and copyright legislation, and with the University's web 

accessibility policy. 

For further information on your responsibilities as a web publisher, please 

refer to www.bristol.ac.uk/style-guides/web/policies/. 

http://t4cms.bris.ac.uk/
http://t4cms.bris.ac.uk/
http://www.bristol.ac.uk/secretary/dataprotection/
http://www.bristol.ac.uk/foi/
http://www.bristol.ac.uk/foi/
http://www.bristol.ac.uk/web/guide/gettingstarted/copyright/
http://www.bristol.ac.uk/web/policies/full-access.html
http://www.bristol.ac.uk/web/policies/full-access.html
http://www.bristol.ac.uk/style-guides/web/policies/
http://www.bristol.ac.uk/style-guides/web/policies/
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2. To access a University website click on Sign in with SSO button in the 

Single Sign-On option at the top, and enter your UoB username and 

password when prompted 

 

1.2 User rights and roles 

In Site Manager, users can only be given one of 4 publishing roles: Contributor, 

Moderator, Power User and Administrator (Figure 2). 

 

Figure 2: User rights and roles in Site Manager 

The default role for all University web publishers is Moderator. Exceptionally 

some users may be granted a Contributor role, depending on requirements. 

When using this document for self-study, log in to the training 

environment using the username and password provided by the 

central Digital Communications Team. 

If you don’t have these details, email web-editor@bristol.ac.uk to 

request them. 

Make a note of the training site and login details provided by the 

tutor: 

Username : __________________ 

Password : __________________ 

 

1. Open t4cms.bris.ac.uk in a browser. 

2. Enter the above details in the Non-University of Bristol sign-on 

box and click on the Login button. 

mailto:web-editor@bristol.ac.uk
http://t4cms.bris.ac.uk/
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Things you CAN do as a Moderator: 

✓ add, modify and delete content within existing Sections (web pages) 

✓ add, modify and delete Sections (web pages) 

✓ use the Media Library to manage site assets (e.g. images, PDFs) 

✓ manage links in the left navigation menu 

✓ approve content changes for publication 

✓ modify the site properties. * 

* see note at the bottom of this page. 

Things you CANNOT do as a Moderator: 

 manage users 

 modify the template 

 empty the recycle bin 

 use the Publish now feature. 

1.3 Website structure in Site Manager 

Sections and web pages 

In Site Manager, you build your website’s structure by creating a hierarchy of 

‘Sections’ (see Figure 3) which you can expand or collapse. 

The best way to think of a Section is as a folder AND a web page all in one. It is 

a folder because it can contain other Sections (sub-Sections), AND a web page 

because it displays content (i.e. text and images) within it as a single page. 

 

Figure 3: Sample website structure in Site Manager. 

 

The Section entitled site properties is a special Section. It contains 

properties associated with the website (e.g. the banner title, feedback 

email, style sheets, etc.) and should only be edited by a qualified user (i.e. 

a Web Officer or Site Administrator). 
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Content blocks and Content Types 

A typical Section (i.e. web page) consists of a content area and a Page Layout 

(i.e. a template that defines the styling and formatting of the header, footer and 

left navigation menu) that wraps around it (Figures 3 and 4). 

 

Figure 4 – Sample page built using a single content block 

 

Figure 5 – The same sample page built using two content blocks 

Web pages are formed by adding to the content area one or more content 

blocks using the Content Types available to you. For example, figures – 
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Sample page built using a single content block 4 and 5 above show the same 

page created using a single content block and using two content blocks. 

A Content Type defines the elements (i.e. input fields) that make up the content 

block and how it will be displayed on the page. For example, you can have a 

Content Type for general content, a different one for news articles and another 

one to create an image slideshow. 

Standard web pages (i.e. pages requiring a simple layout and consisting mostly 

of linear text and possibly a few images) typically consist of a single content 

block using the default Content Type (named Content block). 

However breaking down a page into separate content blocks gives you more 

flexibility for 2 reasons: 

• It enables you to mirror (i.e. clone) part of the page on another page. 

• It enables you to apply different Content Types to different blocks, 

which makes it easier to create pages with more complex layouts. 

1.4 The Site Manager interface explained 

Once logged in you are presented with the Site Manager screen (Figure 6) 

which defaults to the Show site structure screen, where you see the site(s) you 

can edit. 

 

Figure 6: Site Manager Contributor interface 

A. User Profile Options – The most useful option here is the Site Structure 

icon which, when clicked, reloads the default Show site structure screen. 

This is like a Home button and it is always safe to click on it. 

You can also change the text size, see your user profile (by clicking on your 

username), search the content of your site and log out. You may ignore the 

Dashboard and Content Language options. 

B. Menu toolbar (Figure 7).– The Content menu contains options to add, 

modify and delete content, as well as access the Site Structure (same as 

above), the Media Library and Approval List. and Help drop-down menus. 

The Rights & Roles menu is of no use because users are managed 

centrally, so just ignore it. 

Similarly, the Help is not of much use, the only option of interest is the 

Extranet which contains generic documentation (it is not always accurate 

and not contextualised to the UoB environment) for contributors and 

moderators (to open it, right-click on it and select Open link in new tab). 
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Figure 7: Content and Help menus options 

C. Current screen title – Shows your current action (e.g. Modify Content; 

Add Content; etc.). Show site structure is the first screen you see after 

logging in; you can always come back to this screen by clicking the Site 

Structure icon in the top menu. 

D. Path – shows the path to the current location within the site structure. 

E. Site structure – Displays the top level (root) Section to which you have 

been granted access, and any sub-Section(s) within it. You can use the  / 

 signs to expand / collapse Sections that contain sub-Sections. This forms 

a hierarchical structure consisting of many levels. 

F. Section drop-down menu – Pointing the mouse cursor to the down arrow 

opposite the Section you want to modify reveals options to add/modify/delete 

content within that Section, as well as preview and bookmark it. 

Moderators also see Section options. 

 

Figure 8: Contributor and Moderator Section drop-down menus 

G. Content status columns – The traffic lights indicate the status of content 

blocks within Sections: 

• Green: content that has been approved for publication. 

• Amber: content pending approval or draft. 

• Red: deleted content currently within the recycle bin waiting to be 

removed after 30 days. 

Digits indicate the number of content blocks within Sections. 

H. Toggle columns – Click to show / hide the content status columns. 
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I. Widget – The Bookmarks panel enables you to create shortcuts to 

Sections you edit frequently. The Approval List is only available to 

Moderators and displays the 10 most recent items submitted for approval. 

J. Bottom menu – This menu offers the same options as the top menu (see A) 

plus the option to bookmark the current screen (it will be listed in the 

Bookmarks widget). 

 

1.5 Content approval process 

The default workflow in Site Manager is quite simple: 

• A piece of content can be in one of 3 states: Draft  Pending  Approved. 

• When a Contributor adds a new content block to a Section, or updates an 

existing one, its status is set to Draft or Pending, depending which save 

option they select. 

• Content whose status is set to Pending must be approved by a Moderator to 

be published on the live site. 

• Moderators have the option to save and approve changes to content in one 

step. 

• Email notification has been disabled, so Contributors have to notify a 

relevant Moderator to ask them to approve their changes. This can be done 

by email. 

• Content blocks and Sections can also have the status of Inactive after they 

have been deleted. Content or Sections marked as Inactive are automatically 

removed from the system after 30 days. 

Publish cycle 

Site Manager publishes new or updated content at regular intervals throughout 

the day. 

Once content has been approved by a Moderator it is included in the next 

available publish: 

• 2:00 

• 4:00 

• 6:00 

• 10:00 

• 12:00 

• 14:00 

• 16:00 

• 18:00 

• 20:00 (Saturdays only: includes all archived content) 

• 22:00 

A publish will normally take up to 1 hour, which means that it can take up to 3 

hours before approved content is visible on the live site. 

For example, content approved at 8.05 am will be included in the 10.00 publish 

but will only appear on the live site sometime before 11:00 at the latest. 
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 2 Managing the site structure 

Objectives In this task you will learn: 

• add a new Section 

• modify an existing Section 

• move and reorder Sections 

• delete Sections 

• duplicate a Branch 

Comments The website structure defines how you organise the content of your site and 

Sections are its building blocks. 

 

2.1 Adding a new Section 

Sections are similar to folders so you use them to organise your content and 

create a hierarchical structure. 

There are two ways to add a new Section in Site Manager: 

• Using the Section drop-down menu – this is the easiest 

• Using the Section SubSections tab 

Method 1: Using the Section drop-down menu 

3. Make sure you are in the Show site structure screen – if not, click on the Site 

Structure icon in the top menu (Error! Reference source not found.). 

 

Figure 9: The Site Structure icon in the top menu 

4. In the site structure, navigate to the Section you want to add a subSection to and 

select Add Section from the drop-down menu opposite (Figure 10). 

 

Figure 10: Adding a Section using the drop-down menu 
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Method 2: Using the Section SubSections tab 

1. Navigate to the Section you want to add another Section to (i.e. a subSection) 

by clicking on its name (Figure 11). 

 

Figure 11: Navigating to the Section you want to add a subSection to 

2. In the Section Modify Section, show details screen, select the SubSections 

tab and click on the + Add SubSection link (Figure 12). 

 

Figure 12: Section SubSections tab screen 

Entering Section details 

Whatever method you choose takes you to the Add Section, Enter Details 

General tab screen (Figure 13). 

You do not need to fill in all the fields, only the first one, Name, is mandatory. 

However a few other fields may be of use and these are identified in Figure 13 

below (numbered from A to F) and explained. 
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Figure 13: Entering Section details 

A. Name (mandatory): This should be descriptive of the Section as it will 

typically appear in the left navigation menu and the breadcrumb trail on the 

live site. Use sentence capitalisation to comply with University house style 

(e.g. Short courses, not Short Courses). 

B. Output URI (highly recommended): The Unique Resource Identifier (URI) 

enables you to specify the path to the page as it will appear in the web 

address. 

If left blank, the Name will be used instead and will be automatically 

converted to a web safe path (i.e. lowercase and any space replaced by a 

dash). 

It is recommended that you specify the Output URI to avoid problems if you 

were to modify the Name later. It should be lowercase and spaces between 

words replaced by a dash. 

For example: 

if the Name is: the Output URI could be: 

Short courses short-courses 

Research themes themes 

C. Description (highly recommended): Use this field to provide an up to 160 

characters summary of the content of the page. This text will be added to 

the page as metadata and will appear under the URL of the page in search 
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engine results pages (SERPs). Every page should have it’s own meta 

description and it should be unique. See https://goo.gl/S6FivF for more 

information. 

D. Status (optional): There are three status levels for Sections: 

• Approved – is the default status for a new Section, which means that 

the Section will be published provided it contains at least one approved 

content block. 

• Pending – displays the Section with a yellow background on the site 

structure and can be used to publish its content all at once (you need to 

approve all content first and then change the Section status to Pending). 

• Inactive – indicates that the Section has been deleted and will therefore 

be removed after 30 days. 

E. Show in navigation (optional): if you want a link to the Section to appear 

in the left navigation menu then ensure it is selected (default). If not, 

deselect it. 

F. Archive Section (optional): Use this option for Sections that are no longer 

updated and do not require to be published every time (e.g. a research 

project that has ended, news from past years). An archive Section will still 

be visible on the live site. 

Click Add when done. 

 

2.2 Modifying an existing Section 

To modify an existing Section: 

1. Starting from the Show site structure screen, navigate to the Section you want 

to modify (alternatively expand the Section drop-down menu opposite the 

Section you want to modify and select Modify Section). 

Try it: 

Create a new practice Section: 

➢ After logging in to the training site (as explained on page Error! 
Bookmark not defined. above), add a Section at the top level using 
your own surname and firstname to name it, as follows: 

• Name: Surname Firstname (e.g. Smith John) 

• Output URI: surname-firstname (e.g. smith-john) 

• Description: e.g. John Smith’s practice Section on T4 Site 
Manager. 

Leave all other options as they are. 

➢ Add 2 or 3 more Sections within the one you just created, for example: 

• About me 

• Interests 

• Contact 

• Resume 

https://goo.gl/S6FivF
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5. In the Modify Section, Show Details screen > General tab, make your 

changes in as illustrated in Figure 13 above. 

6. Click Update to save your changes. 

2.3 Deleting a Section 

1. In the Show site structure screen, expand the Section drop-down menu 

opposite the Section you want to delete and select Delete Section (Figure 14). 

 

Figure 14: Deleting a Section 

A pop up warning will appear asking you to confirm whether you want to proceed 

or cancel. 

2. Click OK in the Delete Section screen to confirm. 

The deleted Section will be clearly marked in a red box with a pink-ish 

background (Figure 15). 

 

Figure 15: Deleted Section in the Site Structure 

 

The Delete command is misleading in Site Manager because it does not 

actually delete the item, instead it changes its status to Inactive, which 

effectively marks it for ‘recycling’. 

Sections marked as Inactive are still visible for a while, until they get 

‘recycled’ (i.e. permanently removed), 30 days after being deleted. 
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Restoring Sections marked as inactive 

Just like ‘deleted’ content, a ‘deleted’ Section can be re-instated as long as it has 

not been recycled. 

1. Click on the deleted Section’s name in the Site Structure and in the Modify 

Section, Show Details screen > General tab, select Pending or Approved 

from the Status drop-down (Figure 16). 

 

Figure 16: Re-instating an Inactive Section 

7. Click Update. 

2.4 Moving a Section 

There are two ways you can move a Section. 

• drag and drop 

• using the drop-down arrow opposite the Section you want to move. 

Method 1: drag and drop 

This is the easiest method. 

1. Starting from the Site Structure, expand the Sections until you see the Section 

you want to move and the one you want to move it to. 

8. Click and hold the Section you want to move and drag it over its new location 

until you see a light blue box around it. Release the mouse button to drop it 

(Figure 17): 

 

Figure 17: Moving a Section using “drag and drop” 

A pop up will prompt you to confirm the action. 

9. Click OK to confirm (or Cancel if you change your mind). 
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Method 2: Using the drop-down arrow Move Section option 

1. In the Show site structure screen, expand the Site Structure until you see the 

Section you want to move. 

10. Point to the Section Drop-Down Menu opposite and select Move Section 

(Figure 18): 

 

Figure 18: Moving a Section using the drop-down arrow menu 

11. When prompted, select the new location for the Section. 

2.5 Duplicating a branch 

Duplicating creates a copy of a Section and all its sub-Sections anywhere in the 

site. 

 

1. Expand the site structure until you see the Section you want to duplicate. 

12. Point the mouse cursor to the drop-down arrow opposite the Section to be 

moved and select Duplicate Section. 

This takes you to the Duplicate Branch screen which contains a number of 

options (Figure 19): 

There is not much difference between a Section and a Branch. The latter 

simply refers to a Section and all the sub-Sections within it, implying that it 

is not possible to duplicate (or move for that matter) a Section without also 

including any sub-Section inside it. 
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Figure 19: Duplicate Branch options screen 

13. Under the Duplication Options heading, select the relevant options: 

• Section to Copy Into: click on Select on the right and navigate to the 

Section you want to copy the duplicate into. 

• Content Options: select Duplicate Content from the drop-down on the 

right if you want to include all content blocks contained within the Section 

and its sub-Sections. 

• Retain Section/Content Link Targets: select to make sure any link to 

other Sections or content blocks are updated. 

• Copy Page Layout Usage: select to ensure any page layout applied to 

the existing branch are applied to its duplicate. 

• Copy User Access Rights: select if you want the same contributors to 

edit the duplicate. 

• Copy Content Type Access Rights: select to ensure all Content Types 

associated with the existing branch are also available for its duplicate. 

• Copy WebDAV Rules: leave this option unchecked. 

14. Click Duplicate. 

A confirmation message will appear at the top of the screen. 

 

Try it: 

Following the instructions above: 

➢ Try to delete, move and duplicate a Section. 
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 3 Adding content to a Section 

Objectives In this task you will learn: 

• how to add content to a Section 

• about Content Types and how to choose between different Content Types 

• about the Content tabs 

• how to enter text using TinyMCE 

• how to preview newly added content 

Comments Remember that a Section is the same as a web page; content is what you add 

to a Section / page. As a Contributor you can add content to existing Sections 

but you cannot create new Sections / pages. 

 

3.1 Methods for adding a new content block to a Section 

There are 3 slightly different ways to do this in Site Manager: 

• using the Section drop-down menu; 

• using the Section Content tab; 

• using the Content menu. 

It is useful to be aware of all of them, although in practice you may have a 

preferred one. 

Method 1: using the Section drop-down menu 

1. Make sure you are in the Show Site Structure screen – if not, click on the Site 

Structure icon in the top menu (see Figure 6 in Section 1.4). 

2. In the Show site structure screen, navigate to the Section you want to add 

content to and point the mouse cursor to the drop-down menu opposite, then 

select Add Content (Figure 20). 

 

Figure 20: Adding content using the Section drop-down menu 
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Method 2: using the Section Content tab: 

1. In the Show site structure screen, navigate to the Section you want to add 

content to (use the  icon to the left of each Section if necessary). When you 

have located it, click on its name (Figure 21). 

 

Figure 21: Selecting the Section you want to add content to 

This takes you to the Section Content tab in the Modify content, select 

content screen. 

2. In the Section Content tab, click on the + Add Content link (Figure 22): 

 

Figure 22: Section Content tab screen 

Method 3: using the Content menu 

1. Point the mouse cursor to the Content menu (not to be confused with the 

Content tab showed above) and select Add Content (Figure 23). 

 

Figure 23: Adding content using the Content drop-down 
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2. On the Add Content, choose a Section screen, navigate to and select the 

Section you want to add content to (Figure 24). 

 

Figure 24: Choose the Section you want to add content to 

3.2 Choosing a Content Type 

Whichever of the 3 methods described above you choose, you will then be 

prompted to choose a Content Type (Figure 25): 

 

Figure 25: Choosing a Content Type 

 

READ THIS BEFORE CONTINUING: 

The University website is currently in the process of being made 

compatible with (i.e. ‘responsive’ to) mobile devices. While this is 

happening there are two flavours of the template available: the original, 

non-responsive template and the new, responsive one. 

1. If your site uses the non-responsive template, then use the 

default content type, named Content block. This is the one used 

in the present document. 

2. If your site uses the responsive template, then you will have a 

choice of 9 different content types. In this case, refer to the 

separate training guide, Publishing responsive web content in 

T4 Site Manager, which explains how to use them. 

It should be obvious which to use, but if in doubt, contact 

web-editor@bristol.ac.uk  

mailto:web-editor@bristol.ac.uk
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1. Unless you’ve been told otherwise, choose Content block under the Global 

category (see Figure 25). 

You now see the Add content, enter content details screen > Content tab 

(Figure 26) consisting of a number of input fields. 

2. Fill in the form fields. 

These will vary depending which Content Type you use, but for the standard 

Content block these fields are: 

• Name – The name of the content block as it will be referred to in Site 

Manager. This field is mandatory but it is not visible to users of the website. 

You can use the same text as for the Title to which you should append [main] 

to indicate that this is the main (and possible unique) content block in the 

Section (e.g. Study [main]). 

• Title – This field is will appear at the top of the page, as a heading level 1 

(h1). It is optional although in most cases you will want to include it. Make it as 

descriptive as possible of the page content (e.g. Study) 

• Body text – This is where you type in the content itself. By default, this field 

uses the TinyMCE visual editor. Using the editor is covered in detail in Error! R

eference source not found.. 

• Keywords – Optionally you can specify keywords for the content block. Use a 

comma to separate keywords. Note that their sole purpose is to make it easier 

to search for a particular content block in Site Manager. 

 

Figure 26: Entering details into the Content Type fields 

• Whenever you see the icon [ ] on this screen there is a tool tip available; just 

point the mouse cursor to it and a tool tip will pop up (Figure 27). 
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Figure 27: Tool tip pop up 

3. Optionally preview your work by clicking on the Preview button (see Figure 28) 

– the preview opens in a new browser tab. 

 

4. Save your work by choosing one of the 3 following options – the default is Add, 

you need to point to the down arrow to see the other two: 

 

Figure 28: Saving options when adding content 

• Add saves the content block and submits it for approval (it will then need to 

be approved separately) – its status is set to Pending and it is saved as 

Version 0.1. 

• Add & Approve saves and approves the content block for publication in one 

step – its status is set to Approved and is saved as Version 1.0. 

• Save as Draft does exactly that – the status of the content block is set to 

Draft and it is saved as Version 0.0.1. 

After saving you will see your new content block listed under the Section 

Content tab (Figure 29). 

 

Figure 29: Newly added content block in Content tab view 

If nothing happens when you try to preview a page, it means your 

browser is set to block pop up windows. 

In Google Chrome, look for the pop-up blocker icon  at the end of the 

location bar and select 

Always show pop-ups from https://t4cms.bris.ac.uk, click Finished 

then try to preview again. 
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You will also see confirmation that the content has been added successfully in 

the shape of a green message box at the top of the screen. 

3.3 Previewing content 

The easiest way to preview content once you have added it or saved it as draft 

is to use the drop-down arrow opposite the content block or Section and select 

Preview (Figure 30). 

 

Figure 30: Previewing a content block 

This opens a preview of the published page in a new browser tab (Figure 31). It 

shows you what the page will look like on the live site. 

 

Figure 31: Preview of published page 
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Try it: 

Add a content block the Sections you created earlier: 

➢ Using any of the methods described above, add a content block to the 
Sections. 

Tips for naming: 

Name: use the same name or an abbreviation of the Section name and 

add main to indicate this is the main content block (e.g. John Smith 

(main); About me (main)) 

Title: use the same as for the Section (e.g. John Smith’s site; About 

me 

Body text: type a few words (copy and paste sample text from 

lipsum.pro if you want) 

Keywords: ignore. 

➢ Before adding (or saving as draft), preview the content that you created 
if you wish. 

http://lipsum.pro/
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 4 Modifying content 

Objectives In this task you will learn: 

• to edit existing content using the Modify Content option 

Comments In the same way that there are a few options for adding new content, there are 

different options for modifying existing content. 

 

4.1 Methods for modifying existing content 

In the same way that you can add content using three different methods in Site 

Manager, you can modify existing content using similar methods: 

• using the Section Content tab; 

• using the Section drop-down menu; 

• using the Content menu. 

Method 1: using the Section Content tab 

1. Expand the site structure until you see the Section containing the content block 

you want to modify. 

2. Click through on the Section name (Figure 32) 

 

Figure 32: Clicking through the Section to edit its content 

3. In the Modify content, select content screen, do one of the following: 

i. Click on the content block you want to edit (Figure 33). 

 

Figure 33: Choose the content block you want to edit 

or: 

ii. Point the mouse cursor to the down arrow of the content block you want 

to edit and select Modify (Figure 34) 



T4 Site Manager for pre-responsive templates 

29 

 

Figure 34: Select Modify from the down arrow options 

Method 2: using the Section drop-down menu 

1. Expand the site structure until you see the Section containing the content block 

you want to modify. 

2. Point the mouse cursor to the Section drop-down menu, then select Modify 

Content (Figure 35): 

 

Figure 35: Modifying content using the drop-down arrow opposite the relevant Section 

3. Do step 3 of the first method. 

Method 3: using the Content menu 

1. Point the mouse cursor to the Content menu and select Modify Content 

(Figure 36). 

 

Figure 36: Modifying content using the Content drop-down 

2. Next, in the Modify content, choose a Section screen, navigate to and select 

the Section you want to add content to (Figure 37). 
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Figure 37: Clicking through the Section to edit its content 

3. Do step 3 of the first method. 

4.2 Modify content, update details screen 

Whatever method you choose, they will open the Modify content, update 

details screen (Figure 38). 

1. Make any change you need to make to any element of the content block (e.g. 

Name, Title, Body text). 

 

Figure 38: Modify content, update details screen 

2. Save your changes by choosing one of the 3 following options – the default is 

Update, you need to point to the down arrow to see the other two (Figure 39). 

 

Figure 39: Saving options when updating content 

 

Try it 

Modify content you created earlier: 

➢ Using the any of the options described above, modify 2 or more of the 
content blocks that you created in Task 3. 
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4.3 The Add/Modify content tabs 

When you add a new content block (or update an existing one) you see the 

Content tab (see Figure 26 above) by default. However, there are five other 

tabs alongside (Figure 40). 

 

Figure 40: Add/Modify content tabs 

General Information 

The General Information tab (Figure 41) shows which Content Type is being 

applied to the content. 

 

Figure 41: Add/Modify content, General Information tab 

Placement 

When you have 2 or more content blocks in a Section, the Placement tab 

(Figure 42) allows you to re-order them. 

 

Figure 42: Add/Modify content, Placement tab 

By default, content blocks are ordered in chronological order (i.e. the newest at 

the bottom). 
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Channels 

The Channels tab (Figure 43) allows you to select which channel(s) the content 

will be published to. 

Channels allow sites to be published in different formats for different outputs. For 

example, in addition to a standard web channel, we may have a mobile channel, 

a tablet channel and a training channel. 

 

Figure 43: Add/Modify content, Channels tab 

 

Options 

The Options tab (Figure 44) allows you to optionally assign publish and expiry 

dates to content blocks to ensure that they are published, unpublished, reviewed 

or archived at the right time. 

 

Figure 44: Add/Modify content, Options tab 

Content that has reached its expiry date is clearly marked as Expired.  

Note there is another, easier, way to re-order content blocks, using the 

Move up and down arrows in the Modify content, select content screen. 

The University website only uses one channel (called the Production 

channel), therefore you should not change the default option in this tab. 
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When a review date has been set, the last person to have modified the content 

will be notified by email. 

Linked Content 

The Linked Content tab (Figure 45) shows which other content blocks within 

Site Manager (if any) have a hyperlink to this particular content block. 

Note that this tab is displayed only when modifying an existing content block, not 

when adding a new one (since it would not be possible to link to a content block 

before it was created). 

 

Figure 45: Modify content, Linked Content tab 
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 5 Managing content 

Objectives In this task you will learn: 

• to delete content 

• to move, duplicate and mirror content 

• to re-order content blocks 

• to view content history and compare versions 

• to bookmark content 

Comments The ability to ‘mirror’ content is particularly useful as it enables you to re-use 

content you want to appear on different pages while maintaining it in one place. 

 

5.1 Deleting content 

To delete content, do the following: 

1. Navigate to the Section which you want to delete content from. Once you have 

located it, click on its name in the Site Structure (Figure 46): 

 

Figure 46: Locating the Section containing the content to be deleted 

2. In the Content tab of the Modify content, select content screen, point the 

mouse cursor to the down arrow to the right of the content block you want to 

delete and select Delete from the drop-down (Figure 47): 

 

Figure 47: Selecting content for deletion 
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A pop up warning will appear asking you to confirm whether you want to proceed 

or cancel. 

If you click OK you will get a confirmation message this particular content block 

has been set to Inactive (Figure 48): 

 

Figure 48: Confirmation of Status changed to Inactive 

 

Restoring content marked as inactive 

‘Deleted’ content can be restored as long as it has not been recycled. 

1. Locate the deleted content block as explained above (see Figure 46). 

2. Click on the name of the content block you want to restore to modify it (Figure 

49): 

 

Figure 49: Opening the content block to be modified 

3. In the Modify content, update details screen, select Update or Save as Draft 

(Figure 50): 

Remember that the ‘delete’ command is misleading in Site Manager 

because it does not actually delete the item, instead it changes its status 

to Inactive, which effectively marks it for ‘recycling’. 

Content blocks marked as Inactive are still visible and can be reinstated. 

However, the system will automatically ‘recycle’ them (i.e. delete forever) 

after 30 days. 
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Figure 50: Reinstating an Inactive content block as Pending or Draft 

The content block status will now show as Pending or Draft. 

5.2 Moving, duplicating and mirroring content 

As well as deleting content, you can move, duplicate and mirror it: 

• Move – means cutting a content block from one Section and pasting it in 

another 

• Duplicate – means creating a copy of a content block and pasting it in the 

same or a different Section. The copy and original are independent from each 

other, so changes made to one will not affect the other. 

• Mirror – is similar to Duplicate except that all copies are linked to each other. 

In other words, any changes made to the original or any of the mirrored 

copies will be reflected in all other copies, so that they are always identical. 

To move, duplicate or mirror content: 

1. Click on the Site Structure icon in the top menu (or in the Content menu drop-

down). 

2. In the Show site structure screen navigate to the Section you want to move, 

duplicate or mirror content from, and either: 

i. select Modify Content from the yellow drop-down menu opposite the 

content, 

or 

ii. click through the Section Name. 

3. In the Content tab, point the mouse cursor to the yellow drop-down arrow menu 

opposite the content block and select the relevant option (Figure 51): 

 

Figure 51: Moving, duplicating or mirroring content 

4. In the Move/Duplicate/Mirror content, select destination screen, navigate to 

the Section you want to move the content to and click on its Name (
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): 

 

Figure 52: Clicking through the Section to move content to 

 

To remove mirrored content from one or more Sections: 

It is possible to remove mirrored content from any Section in which it appears, 

as long as you keep it in at least one Section. 

1. Go to the Section containing the mirrored content block you want to remove. 

2. In the Content tab, point the mouse cursor to the yellow drop-down menu 

opposite the content block and select Delete (Figure 53): 

Mirrored content is identified by a little red ‘snowflake’ icon next to its 

name. 

 
Pointing to the snowflake will show you a list of Sections where the 

content also appears. 

Mirrored content is identified by a little red ‘snowflake’ icon next to its 

name. 

 
Pointing to the snowflake will show you a list of Sections where the 

content also appears. 
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Figure 53: Removing mirrored content 

3. Click OK when asked “Are you sure you want to delete this content?” (or Cancel 

if you’ve changed your mind!). 

4. In the Confirm Content Deletion screen (Figure 54), you are given 2 options: 

 

Figure 54: Confirming how you want mirrored content removed 

• Remove from Section (default): select this option if you want to remove 

the mirrored content from this Section, but keep it in others. 

• Delete Content: will make all mirrored instances of the content 

(including the original block) inactive and mark it for ‘recycling’ (i.e. 

permanent deletion) 

5. Choose the option you want (or keep the default one) and click Confirm. 

 

5.3 Re-ordering content blocks 

You can re-order content blocks within a Section/page in one of two ways: 

• Using the Placement tab (see Section 4.3 above) 

• Using the up and down arrow in the Section Content tab. 

We recommend you use the latter, explained below, as it is much easier. 

Try it 

Following the instructions above: 

➢ try to delete, move, duplicate and/or mirror a content block. 

➢ at the end, try to remove a mirrored content block from one of the 
Section in which it appears. 
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1. Go to the Section (i.e. click on its name or select Modify Section from the 

Section drop-down menu) whose content blocks you want to re-order and select 

the Content tab. 

 

Figure 55: Accessing the Modify Section > Content tab 

2. You have two option to reorder content blocks: manual ordering (default) or 

automatic ordering. By default, use manual ordering as it gives you complete 

control, but automatic ordering can be useful for A-Z index type pages (e.g. list 

of countries, people). 

i. Manual ordering 

Use the up and down arrows under the Move column to move content 

blocks one place at a time (single arrow) or to the top/bottom of the list 

(double arrow). 

 

Figure 56: using the Move arrows to reorder content blocks 

ii. Automatic ordering 

 

Figure 57: using Automatic Ordering to reorder content blocks 
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Enable Automatic Ordering (1). Then choose which content block it 

should apply to (2) by either unlocking individual blocks or all of them 

(click on the open padlock to do this). Finally, select the Method 

(Alphabetical (A-Z) by default) using the drop-down (3). 

3. When done, click Save Changes. 

5.4 Viewing content history and comparing versions 

To view content history: 

1. Navigate to the Section containing the content you want check the history of 

(hint: start from the Show Site Structure screen). 

2. Either click on the yellow drop-down arrow opposite the relevant Section and 

select Modify Content, or click through the Section name. 

3. In the Content tab, click on the drop-down arrow opposite the relevant content 

block and select History (Figure 58): 

 

Figure 58: Accessing the history of a content block 

The History tab in the Modify content, update details screen (Figure 59) 

shows the editing history for a particular content block (e.g. name, version, last 

modified, etc). 

 

Figure 59: Modify content, History tab 

You can also preview a particular version in a different tab by clicking on View, 

and to set an older version as the active one by clicking the Set Active link. 
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To compare two versions: 

Once in the Modify content > History tab (see Figure 59 above), you have two 

options to compare 2 versions at a time: 

• Content Comparison 

• Visual Comparison 

1. Select the two versions you want to compare by ticking the relevant check boxes 

in the Compare column, then choose the comparison mode: 

Content Comparison 

2. Click on the Content Comparison button and in the Compare screen (Figure 

60), first select the field you want to compare (this will usually be the Body text). 

 

Figure 60: Compare screen options 

3. Then click on Text or HTML (choose the former if all you want to do is compare 

the text; if you also want to compare HTML tags, then choose HTML). 

 

Figure 61: Comparing two versions of the same content 

Visual Comparison 

2. Click on the Visual Comparison button. 

This opens the page in preview mode highlighting what has been added in green 

and/or removed in red between the two versions. 
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5.5 Bookmarking pages (Sections) 

Bookmarking allows you to create shortcuts to Sections that you work on 

regularly. You can then access them quickly from the Bookmarks box on the 

right of the screen. 

There are two ways to bookmark Sections: 

• Using the Bookmark Section option in the Section drop-down menu – 

the easiest, but you must be a Moderator! 

• Using the Bookmark link (bottom right of the screen) – use this method 

if you are a Contributor as the other one won’t work! 

Method 1: Using the Section drop-down menu (Moderator) 

1. In the Show site structure screen, point the mouse cursor to the Section drop-

down menu, then select Bookmark Section (Figure 62). 

 

Figure 62: bookmarking a Section using the Section drop-down menu 

That’s it! 

Method 2: Using the Bookmark link at the bottom right of 
the screen (Contributor) 

1. In the site structure, navigate to the Section you want to bookmark and click 

through it to display its Content tab. 

2. Click on the Bookmark link in the bottom right corner of the screen (Figure 63). 

Try it 

Following the instructions above: 

➢ make a few changes to a content block and compare the different 
versions using the 2 comparison modes. 
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Figure 63: Bookmarking content 

3. Replace the text in the Name field with the Section name and click OK (Figure 

64). 

 

Figure 64: Enter the Section name 

4. Click on the Site Structure icon in the top menu. The Section is now listed in the 

Bookmarks box. 

To modify or delete a bookmark: 

1. In the Bookmarks box, click on Edit and then on the Delete icon to remove the 

bookmark or Modify to edit its name (Figure 65). 

 

Figure 65: Modifying or deleting a bookmark 

 

Try it 

Using one of the methods above: 

➢ Bookmark a Section and access it from the Bookmarks box. 
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 6 Using Direct Edit to add and modify 
content 

Objectives In this task you will learn: 

• to access the Direct Edit mode 

• to add content in Direct Edit 

• to modify and delete content in Direct Edit 

• to view content history in Direct Edit 

• to navigate the site structure in Direct Edit 

Comments Direct Edit mode is Site Manager’s highly visual way to edit your site’s content. 

The main benefit is that it can be accessed from a live web page without having 

to log in to the main Site Manager interface first. It is particularly useful for minor 

edits. 

 

6.1 Accessing Direct Edit 

You can access Direct Edit in one of two ways: 

• using the Direct Edit option in the Section drop-down menu in the main 

interface; 

• using the ‘Edit this page’ link on a live web page. 

 

Method 1: using the Direct Edit option in the Section drop-
down menu 

When logged into Site Manager’s main interface, as explained in Task 1, 

Getting to know Site Manager. 

1. From the Show Site Structure screen (Hint: click on the Site Structure icon in 

the top menu or in the Content menu drop-down), navigate to the Section you 

want to add content to. 

2. Point the mouse cursor to the yellow drop-down menu arrow opposite the 

relevant Section and select Direct Edit (Figure 66). 

Direct Edit cannot be used with all pages. In particular news and events 

cannot be created or modified using Direct Edit, as well as pages 

containing tabs or collapsible content. 

It works best on content pages with a simple layout (i.e. pages consisting 

of text in a single column with a few images). 
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Figure 66: Accessing Direct Edit 

Depending on which browser you use, Direct Edit opens in a new tab (Internet 

Explorer) or a new browser window (Google Chrome). 

Method 2: using the ‘Edit this page’ link on a live web page 

1. In a web browser, open your live website and navigate to the page you want to 

modify. 

2. Look for the Edit this page link in the bottom right of the page, just above the 

footer, and click on it (Figure 67). 

 

Figure 67: Accessing Direct Edit through the Edit this page link 

3. Click on Sign in with SSO and enter your UoB username and password. 

6.2 The Direct Edit interface 

 

Figure 68: Direct Edit interface as a Moderator 
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A. Direct Edit toolbar – Here you can: 

• add a new content block to the current Section (Add Content to Current 

Page button) 

• add a new Section (Add New Page button) 

• modify / delete a page (Modify and Delete buttons) 

• approve pending content (Approve button) 

• access the site structure (Site Structure button) to navigate to a 

different Section 

• hide or display the toolbar (click the up / down arrows in the top right) 

B. Content area – Editable content blocks are identifiable by the thin dotted red 

line that delineates them. Hover the mouse cursor inside a content block to 

see the Modify, Delete, History and Approve options. 

6.3 Adding content in Direct Edit 

1. Click on the Add Content to Current Page button and, if prompted, select a 

Content Type (Figure 69). 

 

Figure 69: Adding content and selecting a Content Type 

2. In the Content tab, fill in the content details as you did in Task 2, Adding 

content to a Section (Figure 70). 

 

Figure 70: Filling in the Content details 
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Optionally you may want to fill in the Options tab fields (Figure 71). 

 

Figure 71: Filling in the Options details 

3. Click Save as Draft if you need to make further edits before submitting or Add 

to submit the page for approval. 

6.4 Modifying and deleting content in Direct Edit 

Once a Section contains one content block, it can be edited straight away in 

Direct Edit mode. 

Any content block for which you have editing right is surrounded by a red dotted 

line. 

When you hover the mouse cursor towards the top of this area, it will change 

into an orange dotted line and 3 option tabs will appear in the top left: Modify, 

Delete and History (Figure 72). 

 

Figure 72: Content editing area in Direct Edit mode 

To modify content: 

1. Click on the Modify tab. This takes you to the Modify content screen, which is 

identical to the one you use to add content (see Figure 70 and Figure 71). 

2. Edit your content as desired and click Save as Draft if you need to make further 

edits before submitting or Update to submit the page for approval. 
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To delete content: 

1. Click on the Delete tab. 

2. A window will pop up, prompting you to confirm that you want the content to be 

deleted (Figure 73). 

 

Figure 73: Confirm content deletion window 

You will see a confirmation message appear at the top of the screen for a few 

seconds (Figure 74). 

 

Figure 74: Content deletion confirmation message 

Once deleted, the content will disappear from the page – although you will need 

to reload the page to see the change. 

6.5 Viewing content history in Direct Edit 

1. In the content editing area, click the History tab (Figure 72). 

The View Content history window (Figure 75) shows all the versions listed. 

 

Figure 75: View Content history window 
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It allows you to replace the current (Active) version with a previous one by 

clicking the Set Active link. 

2. Click Cancel to leave the History view. 

6.6 Navigating the site structure in Direct Edit 

1. Clicking on the Site Structure button opens a pop up menu showing the site 

structure (Figure 76). 

 

Figure 76: Site Structure pop up menu 

2. Navigate through the hierarchy to select the Section you want to add content to, 

or whose content you want to modify. Click on the  and  icons to expand / 

collapse Sections. 

Adding a new Section/ Page in Direct Edit 

Although it is possible to add a new Section / page in Direct Edit, it is 

recommended that you do not use this option and use the main interface as 

described in Section 2.1 instead. 

 

Try it 

Following the instructions above: 

➢ Open one of the pages you created in Direct Edit 

➢ Make some changes to it and save them. 
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 7 Adding media to the Media Library 

Objectives In this task you will learn: 

• to access the Media Library 

• to add media files to the Media Library 

• to delete media files from the Media Library 

• to move media files to a different category 

• to optimise images for the web using an online photo editor 

• to manage sub-categories 

Comments If you want to use images in your site or share PDF or other documents types, 

you first need to upload them to the Media Library. 

 

7.1 Introducing the Media Library 

The Media Library is where media files are stored in Site Manager. Media files 

include images, PDF files, Microsoft Office files, style sheets and scripts, but not 

videos. Once in the Media Library files are easy to access from within Site 

Manager’s visual content editor, for example to create a link to a PDF file or 

insert an image in a web page. 

The Media Library interface 

 

Figure 77: The Media Library interface in Detailed (list) Mode 

A. Resize categories view navigation menu – allows you to widen or narrow 

the categories navigation menu. 

B. Add / Move / Delete Media buttons – use to upload a new media file, move 

a file to a different category or delete. 

C. Search – allows you to search for items in the Media Library, by name, 

keywords or description. 

D. Jump – allows you to search for media items by ID (if you happen to 

know it which is unlikely). Ignore. 

E. Filter – allows you to filter which file types are displayed (e.g. Image, 

Adobe PDF Document, Script, etc). 

F. Views – allow you to select how the media items are displayed. Click the 

icons to toggle between Detailed Mode and Preview Mode. 
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G. Categories navigation menu – displays the hierarchy of available 

categories. 

H. Media items – this areas displays the content of the chosen category, in 

Detailed Mode or in Preview Mode (see F). 

7.2 Accessing your site’s Media Library 

1. Go to Content > Media Library (Figure 78). 

 

Figure 78: Accessing the Media Library 

2. Expand the sites category on the left to find your site’s top level category and 

sub-categories. 

 

Figure 79: Finding your site’s top level category 

 

 

 

In addition to sites, you will see two other main categories maintained by 

the Digital Communications Team: resources and shared. 

• resources contains template style sheets, scripts and images and can 

only be used by higher level users. 

• although currently empty, with time shared will be populated with 

University copyrighted images that you could use in your website. 
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7.3 Uploading files to the Media Library 

 

1. Select the sub-category to which you want to add a media file and click on the 

Add Media button (Figure 80). 

 

Figure 80: Add Media button 

15. In the Media Library screen, General tab, (Figure 81), fill in the Name and 

Media fields as follows: 

• Name: enter a brief description of the media (in the case of a PDF or 

Office file enter the document title). 

• Media: use this field to navigate to the media file location on your 

system. 

 

Figure 81: Media Library General tab options for uploading a new media 

Before uploading files to the Media Library, make sure that all file 

names are web-safe, i.e.: 

• all lower case (no capital letters); 

• not containing spaces (use a hyphen to separate words); 

• not containing special characters (e.g. accented characters); 

• include the appropriate extension (e.g. .jpg; .pdf, etc). 

Example: Fire Safety Policy.pdf  fire-safety-policy.pdf ✓ 

Beware that non-web-safe file names may result in broken links in some 

browsers. 
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16. Click Add when done. 

The media is now listed in the relevant category (Figure 82): 

 

Figure 82: Newly added media 

7.4 Working with images on the web 

Before using an image on a website, it is good practice to optimise it for the web. 

This means re-sizing it to the pixel dimensions (i.e. width and height) you want it 

to take up on the page and reducing its file size, and ensuring that it is in a 

suitable format. 

What is a good image size? 

A good size for an image depends on how you are planning to use it, but as a 

rule of thumb, 955 pixels is the maximum width needed on the University 

website (for a full page width banner for example). 

In the case of images used to illustrate a standard page and positioned to the 

right with the text on the left, you should use the recommended width of 283 

pixels to ensure the image fits properly within the page layout. 

However there may be occasions (e.g. when it contains a lot of small details or 

textual information) when the image needs to be wider than 283 pixels. 

Note that the height is not so important, so you should always decide on the 

width first. 

What tools to use for resizing and cropping images? 

The quickest is to use a free online tool like Web Photo Resizer 

(http://www.webresizer.com) or Pixlr (http://pixlr.com): 

• Web Photo Resizer is very easy to use: click on the Resize Photos 

Now button, upload your image, set the width (leaving all other options 

as they are), click the apply changes button and download the resized 

image. 

• Pixlr is a full blown image editor with Photoshop like capabilities. 

Choose the advanced option (Pixlr editor) and select Open image from 

computer to upload an image. Then go to Image > Image size and 

When uploading images, DO NOT enter anything in the Description field 

as this would be used by default as the image alternative text and may not 

be appropriate to the context in which the image is used, or reflect its 

function (e.g. if used as a link). It is better to enter a description when 

inserting the image in a page. 

http://www.webresizer.com/
http://pixlr.com/
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enter the width you want (the height will automatically adjust provided 

Constrain proportions is selected). Click OK. Go to File > Save 

(choose a suitable file format – see below). 

Alternatively use Serif PhotoPlus which should be pre-installed on your 

University computer (go to Start > All Programs > Serif Applications) or any 

other photo editor you may have access to (e.g. Photoshop CS / Elements, 

Google Picasa, etc). 

Which file format? 

There are three file formats for the web: 

• JPG (or JPEG): best for photos and images with lots of colours but no 

transparency. You can set the level of quality between 10% and 100% - 

don’t go for 100% for web images, instead choose 80% which is still 

high, but will reduce the file size considerably. 

• GIF: for a long time the default format for logos and graphics with solid 

areas of colour. However it can only display a maximum of 256 colours 

and for this reason it is not suitable for photos. 

• PNG: seen as a replacement for GIF, over which it has many 

advantages: not limited to 256 colours; better transparency support 

(useful for creating images with transparent backgrounds); smaller file 

size (a PNG image is about 20% smaller than the same images saved 

as GIF). You should use this format instead of GIF whenever possible. 

 

 

 

Try it 

Following the instructions above: 

1. Optimise an image using Web Photo Resizer: 

➢ Open webresizer.com in a browser. 

➢ Click on the Resize Photos Now button and upload an image (use 
images located in Favorites > Public > Public Pictures > Sample 
Pictures) – note that the maximum size allowed is 10MB. 

➢ Set the width size to 283px, leave the Sharpen and Image quality 
options as they are. 

➢ Click on the apply changes button followed by the download this 
image link and save the optimised image locally (e.g. in Favorites > 
Downloads) – at this stage don’t forget to rename the file to a web-
safe name (see note on previous page). 

➢ If you have time you can also try the crop option with another image 
and save it in the same folder. 

2. Upload your image to the Media Library: 

➢ Upload the image you have just optimised to the Training > images 
category. 

➢ Optionally, add a PDF file to the Training > documents category. 

http://www.webresizer.com/
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7.5 Deleting media from the Media Library 

To delete individual media 

In the View Media in Detailed mode: 

Click on the Delete icon opposite the media you want to delete (Figure 83) and 

confirm when prompted: 

 

Figure 83: Deleting in the View Media in Detailed Mode 

In the View Media in Preview mode: 

1. Hover the mouse cursor over the media you want to delete and click on the 

Advanced button (Figure 84). 

 

Figure 84: Deleting in the View Media in Preview Mode 

This opens the media details view (Figure 85). 

 

Figure 85: Media details view, Delete 

2. Click Delete and confirm when prompted. 
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To delete several media files at once 

In the View Media in Detailed mode view: 

1. Select the file(s) you want to delete in the Select All column on the left. 

2. Press the Delete Media button. 

 

Figure 86: Deleting several files at once 

 

7.6 Assigning media to other categories 

By default, media item are assigned to the category in which they are added. 

However it is possible to move a media file to a different category or assign a 

media item to several categories. 

The latter is particularly useful when you want a media file to appear under 

different categories without duplicating it. For example if you have a photograph 

of a person in a particular location, you may want it to appear under a sub-

category named people and another named places. 

To move a file to a different category 

In the View Media in Detailed mode view: 

1. Select the file(s) you want to move in the Select All column on the left. 

2. Press the Move Media button. 

Notice that if the media file you try to delete is used on a page you will 

receive a warning like the one below: 

 

In this case Cancel, as this would result in a broken link on those 

pages that have a link to it. 
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Figure 87: Moving media files 

3. In the pop-up box, select the new category and press Move Media (Figure 88). 

 

Figure 88: Selecting a new category for the file(s) 

To assign a media file to several categories 

In the View Media in Detailed mode: 

1. Click either on the Media Name (and then the Modify button on the next 

screen), or on the Modify icon opposite the media you want to modify (Figure 

89). 

 

Figure 89: Modifying in the View Media in Detailed Mode 

 

 

2. Select the Categories tab (Figure 90). 
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Figure 90: Selecting the Categories tab 

3. Once in the Media Categories screen, select or de-select the categories you 

want to add or remove the media in / from (Figure 91) and click Update. 

 

Figure 91: Selecting / de-selecting categories 

In the View Media in Preview mode: 

1. Hover the mouse cursor over the media you want to delete and click on the 

Advanced button (see Figure 84 above). 

2. In the media details view, click Modify (Figure 92). 

 

Figure 92: Media details view, Modify 

3. Follow steps 2 to 3 above. 

7.7 Managing sub-categories 

To add a sub-category 

1. Go to Content > Media Library (Figure 93): 
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Figure 93: accessing the Media Library 

2. Expand the category structure if necessary by clicking on the  sign next to the 

category you want to expand. 

Now do one of two things: 

• Click on the parent category (i.e. the category in which you want to add a new 

category – a pale yellow background highlights it). Hover over Options and 

select Add Category (Figure 94): 

 

Figure 94: adding a category using the Options menu 

a) Right-click on the relevant parent category and select Add Sub-Category 

(Figure 95): 

 

Figure 95: adding a sub-category 
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Whichever method you choose, an input dialogue box pops up, prompting you to 

enter a name for the new category (Figure 96): 

 

Figure 96: new category name input prompt 

3. Type in a name for the new category and click OK. 

The new category now appears in the Media Library structure, within the 

selected parent category. 

To delete a sub-category 

1. Do one of the following: 

a) Click on sub-category you want to delete to select it. Hover over Options 

and select Delete Category (see Figure 94 above). 

b) Right-click on the sub-category you want to delete and select Delete (see 

Figure 95). 

2. Click OK to confirm. 

The category and all its content are removed from the Media Library to the 

Recycle area, where they will be deleted forever at the next purge. 

To rename a sub-category 

1. Right-click on the sub-category you want to rename and select Rename (see 

Figure 95). 

2. Type in a new name for the new category in the pop-up input dialogue box (see 

Figure 96 above) and click OK. 

To move a sub-category 

1. Right-click on the sub-category you want to rename and select Move (see 

Figure 95). 

A new window opens, showing the Media Library Site Structure. 

2. Click on the new category you want to move it in. 

 

 

Try it 

Following the instructions above, create a sub-category in the Media Library: 

➢ Open the Media Library and in the Training > images category, 
create a sub-category using your training site name (e.g. John Smith – 
it’s ok to use uppercase and spaces) as its name. 

➢ Try to move the file(s) you uploaded earlier to it. 
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 8 Editing and formatting text in 
TinyMCE 

Objectives In this task you will learn: 

• to use basic text formatting (e.g. headings, lists, etc) correctly 

• to create links (to other websites, to Sections in your website and to 

bookmarks within a page) 

• to create links to non-HTML files (e.g. PDFs) stored in the Media Library 

• to create data tables 

• to add and position images from the Media Library 

Comments This final task focuses on editing the content of pages using TinyMCE, a simple 

WYSIWYG1 content editor. Whatever editing method you use (standard or Direct 

Edit) you will use TinyMCE 

 

8.1 Before you start 

The content editor toolbar 

The content editor toolbar (Figure 97) will be familiar as it uses similar icons to 

those seen in other word processing applications such as Microsoft Word; for 

example icons for making text bold, creating bullet lists, etc. 

However some icons will be new as they are specific to web content editing 

within Site Manager. 

 

Figure 97: TinyMCE content editor toolbar 

The faded out tools are inactive until needed (e.g. the table formatting options at 

the bottom become active when a table has been created and is selected). 

For a full list of tools available in TinyMCE, please refer to Appendix A. 

                                                      

1 What You See Is What You Get 
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Working in full screen mode 

For longer edit and when working in Direct Edit mode you may want to switch 

the editor to full screen. 

To do this, click on the Toggle fullscreen mode icon (Figure 98). Click on it 

again to go back to Site Manager or Direct Edit view. 

 

Figure 98: Switching to full screen mode for easier editing 

 

The context menu 

The context menu can be accessed by right-clicking on any element (word, 

paragraph, image, table cell, etc) on the page. 

The tools available in the context menu depend on the actions that are possible 

with the currently selected element in the WYSIWYG view of the editor. 

Copying and pasting content from other sources 

The cut, copy and paste options currently only work in Internet 

Explorer, so if you use Google Chrome or Firefox, you will need to 

use the keyboard shortcuts (i.e. <Ctrl> + X for cut, <Ctrl> + C for 

copy and <Ctrl> + V for paste). 

Copying and pasting from a Microsoft Word, a PDF 

document, Google Mail or a web page: 

 

We recommend that you always use the paste as plain text option. 

This avoids any chance of copying any unwanted formatting or 

styling into the webpage that you are creating. 

Before pasting, click on the Paste as Plain Text icon  and THEN 

the Paste icon (or <Ctrl> + V). 

You may still need to reformat your content in TinyMCE afterwards. 

 

BEWARE the back button in your browser as using it to exit the fullscreen 

mode will result in losing all your changes! 

For the same reason make sure you do not close the browser tab or 

window by mistake. 
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For example right-clicking on a group of selected words will give you the options 

to cut, copy and paste, and to insert a link (Figure 99). 

 

Figure 99: Accessing the context menu 

8.2 Structuring text: paragraphs, headings and lists 

Paragraphs and headings 

When you start typing the text will be automatically formatted as a paragraph: 

• Pressing <ENTER> will create a new paragraph. 

• Pressing <SHIFT> + <ENTER> will create a line break. 

To create a heading, place the mouse cursor anywhere in the text you want to 

turn into a heading (there is no need to select it all) and select one of the options 

from the Format drop-down box in the Toolbar (Figure 100). 

 

Figure 100: Creating a level 2 heading 

 

Heading formatting options starts from Heading 2 because Heading 1 

is reserved for the page title and is automatically created by the system 

when using a Content Type with a Title field. 

Rules for using headings: 

1. Use the different heading levels in their intended, logical order 

(i.e. start from Heading 2 to introduce the main Sections in your 

page, followed by Heading 3 for sub-Sections and, if necessary 

Heading 4 for sub-sub-Sections). 

2. Finally, use headings for their intended purpose (i.e. as Section 

headings); do not use them for anything else (e.g. for making text 

bold or for image captions). 
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Lists 

Lists come in two types: unordered (ie bullet) and ordered (ie numbered). To 

insert a list: 

1. Type the list items one by one as separate paragraphs (press <ENTER> at the 

end of each item). 

2. Select all items with the mouse and click either of the list icons:  for an 

unordered list and  for an ordered list. 

3. To take a list item out of a list, click the same list icon (it is highlighted) again – 

the item is automatically formatted as a paragraph. 

 

8.3 Creating links 

There are three ways to create links in Site Manager, depending on the target of 

the link: 

• an external web page 

• an email address 

• another page in your site 

• a PDF or Microsoft Office file. 

Linking to external websites 

1. Select the text you want to make a link then click on the Insert/edit link icon 

 in the toolbar. This opens the Insert/Edit Link dialogue box (Figure 101). 

Try it 

Following the instructions above: 

1. Copy and paste content: 

➢ Open a familiar web page (e.g. 
http://www.bristol.ac.uk/university/history/), select a few paragraphs 
of text and copy it (CTRL + C). 

➢ Modify one of the content blocks you created earlier and paste the 
text (CTRL + V). 

2. Add formatting to the text: 

➢ Add a couple of sub-headings and format them accordingly. 

➢ Add a list of 3 or 4 items. 

➢ Save your changes. 

http://www.bristol.ac.uk/university/history/
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Figure 101: Insert/Edit Link dialogue box, General tab options 

2. In the Link URL field, type in (or paste) the external website URL (e.g. 

http://www.bbc.co.uk/news for a link to the BBC News website) – if you forget to 

include the http:// prefix a message will pop up asking if you want it added; click 

OK to accept. 

• Target attribute: leave the default option Open in This Window/Frame 

– exceptionally you may change it to Open in New Window (_blank). 

• Title attribute: use this to provide additional text to describe the link or 

add useful information about the link. 

For example if you forced a link to open in a new window you could use 

the Title attribute to warn users by saying link opens in new window. 

• Ignore the Class attribute and the other tabs. 

3. Click the Insert button. 

Linking to another Section or content block in Site Manager 

1. Select the text you want to make a link then click on the Insert Section Link 

icon  in the toolbar. This opens the Choose a Section to link dialogue box 

(Figure 102). 

 

Figure 102: Choose a Section to link dialogue box 

2. Using the Site Structure, navigate to the Section you want to link to. 

http://www.bbc.co.uk/news


T4 Site Manager for pre-responsive templates 

66 

 

Linking to a non-web document (i.e. an Office or PDF file) 

1. Place the mouse cursor where you want to insert your link and click on the Insert 

Media icon . 

This opens the Media Library browser (Figure 103). 

 

Figure 103: Media Library browser 

2. In the Media Library browser, navigate to the folder containing the file you want 

to link to and click on its name in the Media Name column. 

The file Media Name as well as the file type and size in brackets will be 

automatically used as the link text. 

Linking to an email address (mailto link) 

 

1. Select the text you want to link to an email address and click on the Insert/Edit 

link button . 

2. In the Link URL field type in (or paste) the email address (e.g. 

joe.blog@bristol.ac.uk) and click Insert. 

3. Click OK when prompted to add the required mailto: prefix. 

 

The Site Structure shows the entire University website starting from the 

University homepage. Therefore you can use this method to link to any 

website hosted in T4 Site Manager. 

For other University websites not in Site Manager you will need to use the 

method for linking to external websites. 

The mailto link text should clearly indicate that the link will activate an 

email program. This can be achieved by either using the email address as 

the link (e.g. joe.blog@bristol.ac.uk) or a phrase like Email the School of 

Humanities office. 

If you copy a linked email address from a web page (e.g. from the 

University Contact Directory), make sure you click on the Paste as Plain 

Text button  before pasting. This is particularly important if you use 

Google Chrome as it will force the mail to link to open Google Mail. 

mailto:joe.blog@bristol.ac.uk
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8.4 Adding and positioning images 

Selecting an image from the Media Library: 

1. Place the mouse cursor where you want to insert your image (this should be 

either between two paragraph or at the beginning of a paragraph when you want 

to “float” the image to the right – see Right aligning the image: on p.55) and 

click on the Insert Media icon  to open the Media Library browser. 

 

2. In the Media Library browser, find the image you want to insert and select it by 

hovering over the image and clicking Select (Figure 104). 

Try it 

Following the instructions above: 

1. Create external links 

➢ Modify again a content block you created earlier and in the body 
text field create links to a couple of your favourite websites 

2. Create internal links 

➢ Create a link to a page within your training site (make sure you 
select from the training channel wwwtrain.bristol.ac.uk). 

3. Create a link to a non-web document 

➢ Create a link to the PDF document in the Media Library training > 
documents category. 

4. Create a link to an email address 

➢ Create a link to your own email address 

If the Media Library browser opens in View Media in Detailed Mode 

(i.e. as a list as shown in Figure 103 above), switch to View Media in 

Preview Mode (i.e. with thumbnails) as in  

 

http://wwwtrain.bristol.ac.uk/
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Figure 104: Selecting an image from the Media Library 

Modifying the image attributes: 

1. Left-click on the image to select it and then right-click to open the context menu, 

select Edit Media Attributes (Figure 105). 

 

Figure 105: accessing the Media Attributes dialogue box 

This opens the Set Media Attribute dialogue box (Figure 106): 

 

Figure 106: Setting the media attributes 
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Specifying a description (alternative text) 

 

2. If relevant (see Top tip below), in the description field enter a short description 

of the image. 

 

Right aligning the image: 

You can easily align an image to the right of your page with the text on the left 

by applying a style class (note that there is no equivalent class to align images 

to the left). 

For this to work, place the cursor at the beginning of the paragraph with 

which you want to align the image and open the Set Media Attributes dialogue 

box as explained in 1 above. 

3. In the class field, enter one of the following style classes: 

a. align-right when the image is the standard width (283 pixels); 

b. align-right-no-width when the image width is different from 283 pixels. 

4. Click Update and Update again (or Save as Draft) when back in the Content 

tab view. 

Preview the page if you want to see your changes. 

Providing Alt text for non-text elements on a web page is a fundamental 

principle of web accessibility. 

Although this is primarily intended for the benefit of text-to-speech 

software users (i.e. blind people), other users may benefit too (e.g. those 

using a text-only browser). 

To write a good image description (Alt text), ask yourself: 

1. Is the image used as a link? 

Yes: use the description field to describe the image AND use 

the title attribute to indicate what happens when the image is 

clicked (e.g. Opens the Wikipedia entry for…) 

No: continue 

2. Does the image convey important information? 

Yes: 

• if a simple graphic or photograph, use the description field 

to provide a brief factual description of the image; 

• if the image contains text, use the description field to 

provide the exact same text; 

• if a complex image (e.g. graph, pie chart), use the 

description field to provide a short description AND provide 

the information contained in the image as text on the page. 

No: the image is purely decorative (i.e. does not contain useful 

information), you can leave the description field empty. 

For further information, see: webaim.org/techniques/alttext/ 

http://webaim.org/techniques/alttext/
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8.5 Creating data tables 

 

Basic table creation 

1. Place the mouse cursor where you want to insert a data table and click on the 

Insert a new table icon . This opens the Insert/Edit Table dialogue box and 

shows the General settings (Figure 107): 

Set the options for your table using the General settings as follows: 

• Cols / Rows: sets the number of columns and rows including header 

rows/columns. 

• Cell Padding: adds space between the edges of cells and the text; set it 

to 4 or 5 pixels. 

• Cell Spacing: adds space between cells; best left to 0. 

• Alignment: sets the horizontal alignment: Left (default), Center and 

Right; best left to default as this can be set in a style sheet. 

• Width / Height: leave blank as this is best left to adjust automatically to 

fit the text. 

• Class: can be used to link to a style sheet. 

• Table Caption: tick this box (you will then need to type a caption above 

your table). 

• Make first row / column a header: defines header rows / columns; your 

table should have a header row, so tick this box, and optionally the 

header column option. 

Try it 

Following the instructions above: 

➢ Insert the image you uploaded to the Media Library earlier in one of 
your pages. 

➢ Apply the relevant class to position it to the right. 

➢ Update and preview your changes. 

Data tables should be used to present lists of at least two related items 

with two or more categories of information (i.e. at least two rows and two 

columns), and to compare numerical data. 
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Figure 107: Insert/Edit Table General options 

2. Click Insert. 

You will now see the outline of an empty table (Figure 108) 

 

Figure 108: outline of a 4 row, 4 column table with caption 

3. Enter a caption at the top, then the column headers in the first row (optionally 

the row headers in the first column headers) and the data in the other cells. 

Making tables accessible 

 

Data tables can be difficult (if not impossible) to interpret for text-to-

speech software users (e.g. blind users), particularly when used to 

compare numbers. 

It is therefore an accessibility requirement to ensure that information 

presented in a data table can be understood by the visually impaired. 

See accessibility.psu.edu/tableshtml for further information on data table 

accessibility. 

http://accessibility.psu.edu/tableshtml
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Adding a table summary 

1. Left-click anywhere in the table and then right-click. In the pop-up context menu 

select Table Properties. 

2. In the Insert/Edit Table dialogue box, select the Advanced tab (Figure 109). 

 

Figure 109: Insert/Edit Table Advanced options 

3. In the Summary field enter a brief description of the table (e.g. Table 

representing the percentages of UK adults who drink wine by age group). 

Leave all other fields empty (in particular do not use the Border Color and 

Background Color as this is better done in a style sheet). 

4. Click Update when done. 

Defining the header row and column 

1. Left-click anywhere on the header row (i.e. the top row) and then right-click. 

Select Cell > Table Cell Properties (Figure 110). 

 

Figure 110: Selecting the Table Cell Properties 

2. In the Table Cell Properties dialogue box (Figure 111): 

• check that the Cell Type is set to Header; 

• set the Scope option to Column; 

• select Update All Cells in Row from the drop-down just above the 

Update button; 



T4 Site Manager for pre-responsive templates 

73 

• click Update when done. 

 

Figure 111: Table Cell Properties dialogue box 

If the table has a header column on the left, repeat these steps, setting the 

Scope to Row and the drop-down field above the Update button to Update All 

Cells in Column. 

Defining table head and body 

1. Finally, left-click on the header row again, then right-click and select Cell > 

Table Row Properties. 

In the Table Row Properties dialogue box (Figure 112): 

• set the Row Type to Header; 

• check that the drop-down option above the Update button is set to 

Update Current Row; 

• click Update. 

 

Figure 112: Table Row Properties dialogue box 

Applying basic styling 

1. Left-click anywhere in the table and then right-click. In the pop-up context menu 

select Table Properties. 
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2. In the Class attribute, select (value) from the drop-down and type table-basic in 

the now blank field (Figure 113). 

 

Figure 113: Adding basic styling to a table 

 

 

The CSS class table-basic is part of the UoB template stylesheet and 

defines default styling for data tables. 

Try it 

Following the instructions above: 

➢ Create a simple data table with a header row and a header column 
using your own or the following data: 

 2012 2011 2010 2009 2008 

Red Bordeaux 8 8 10 10 8 

White Bordeaux 7 8 7 7 8 

Red Burgundy 9 8 9 9 7 

White Burgundy 8 8 9 8 7 

Caption: French Vintages 2008-2012 

Summary: French vintages score out of 10 from 2008 to 2012 

➢ Make sure the table is fully accessible. 

➢ Update and preview. 
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 9 Publishing content 

Objectives In this task you will learn to: 

• approve content 

• reject content 

Comments As a Moderator you may have to approve new or modified content submitted by 

Contributors in your team. Once approved, a content block will be published to 

the live site at the next publish cycle (normally every 2 hours on even hours). 

 

There are two ways publish content in Site Manager: 

• using the Approval List in the main interface; 

• using Direct Edit. 

9.1 Using the Approval List to approve/reject content 

When in the Show site structure screen look for the Approval List on the right 

(Figure 114). 

 

Figure 114: Approval List 

This list shows the 10 most recent content blocks that are pending. 

If you see the item you want to approve in the list: 

1. Click on its name in the list. 

This opens the Approve Content screen > Details tab (Figure 115). 
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Figure 115: Approve Content screen, Details tab 

2. To preview the content, click on the relevant channel name (Production for the 

live University website) under Published Channels. 

This opens a preview of the page in a new tab or window. 

3. After previewing the page click Approve. 

You can also edit the content yourself by clicking on Edit (this opens in a new 

tab) and making your changes as desired before selecting Update & Approve 

from the Update drop-down. 

If you don’t see the item you want to approve (or want to see a full 

list of pending items): 

1. Click on View All at the bottom of the Approval List or point to the Content 

menu and select Approve Content. 

This takes you to the Approve Content screen which lists all Pending content 

(Figure 116). 

 

Figure 116: Approve Content screen showing list of pending content 

2. Click on the name of the pending content you want to approve and follow steps 

2 and 3 above. 

You can also approve several items at once by selecting the corresponding 

check boxes on the right (or if you want to select them all using the Select All 

option at the bottom of the screen, then click Approve. 
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However this option should be used with caution as approving content without 

checking it first can be risky! 

Rejecting content 

If you need to reject content: 

1. When in the Approve Content screen > Details tab (see Error! Reference s

ource not found. above), click on Reject. 

This opens the Approve Content screen > Details tab form for rejected content 

(Figure 117). 

 

Figure 117: rejected content form 

2. Enter the reason why you are rejecting the content in the Reject Reason box. 

3. Click Submit. 

By default the last person to have modified the content block will be notified by 

email. 

 

9.2 Using Direct Edit to approve/reject content 

One of the problems with the approval process presented in Section 9.1 is that it 

can sometimes be difficult to identify which content is your responsibility in the 

approval list. 

This is particularly true in the case of large sites with many Contributors and 

Moderators. 

To get around this problem use the Direct Edit method as follows: 

Try it 

Following the instructions above, approve pending content blocks on your 

site: 

➢ Look in your Approval List (or use the Content menu > Approve 
Content option) for pending content. 

➢ Approve 2 or 3 items, previewing and/or editing them first if you want. 
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1. Ask the Contributors in your team to send you an email including the URL of the 

live page that they have modified (and possibly details of the changes they have 

made). 

2. Open the page in a browser and click on the Edit this page link in the bottom 

right. 

3. Log in to access the page in Direct Edit mode, then check the changes. Point 

the mouse cursor inside the editable area until you see the Modify, Delete, 

History and Approve options. 

4. In the Approve drop-down select Approve (Figure 118) and then again 

Approve when prompted. 

If you select Reject you will be prompted to enter the reason for rejecting. 

 

Figure 118: Approve options in Direct Edit 

 

 

You can also access the entire approval list by clicking Approve in the 

Direct Edit toolbar. 
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 10 Managing the left navigation menu 

Objectives In this task you will learn to: 

• show / hide a Section from the left navigation menu 

• reorder links in the left navigation menu 

Comments The main navigation menu for your website is located on the left-hand side of 

the page, and is automatically generated from the site structure. 

 

10.1 Overview 

There are different navigation menus available to visitors on the University 

website (Figure 119). 

• Global navigation: this is the main University level navigation, which is 

part of the template and is showed on all pages. 

• Breadcrumb trail: this reflects the site’s structure starting from the 

University homepage and is automatically created. 

• Left navigation menu: automatically generated from the site’s structure, 

but can be edited (i.e. you can hide Sections from it, add links manually 

and reorder links). Links expand to show links to sub-Sections down to 3 

levels. 

• In page navigation: this is optional and is added manually within a 

content block. 

 

Figure 119: Navigation menus on a typical University website 

There is also a ‘fat’ footer navigation menu containing global University links as 

well as an a-z index (Figure 120) 



T4 Site Manager for pre-responsive templates 

80 

 

Figure 120: Global University ‘fat’ footer navigation menu 

10.2 Showing / hiding a Section from the left navigation 
menu 

As mentioned before (see p.14, Entering Section details), when you add a new 

Section (or update and existing one) there is an option to show or hide it from 

the left navigation menu. 

By default, this option is checked (meaning a link will be created in the left 

navigation menu). 

To hide a Section from the left navigation menu 

1. Go to the Add / Modify Section screen General tab and look for the Show in 

navigation? option (Figure 121). 

 

Figure 121: Show in navigation option 

2. Deselect the Show in navigation? option check box. 

3. Click Add / Update. 

When hidden, the Section will appear as greyed out in the site structure. 
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10.3 Reordering navigation links 

By default, the left navigation menu links are ordered in the order in which 

Sections are created. So every time you add a new Section, a link to it will be 

added below all preceding links. 

To re-order the left navigation links 

1 Starting from the Show Site Structure screen, expand the site structure and 

navigate to the Section whose links you want to re-order. 

2 Once in the Modify Section, Show Details screen, select the SubSections tab 

on the right (Figure 122). 

 

Figure 122: Section SubSections tab view 

The sub-Sections are listed at the bottom, under the Name column. 

3 Use the up and down arrows on the right to re-order the sub-Sections (Figure 

123). 

 

Figure 123: re-ordering Section links using the Move up/down arrows 

4. Click Save Changes. 

 

Try it 

Following the instructions above: 

➢ Go to your own top level Section and in the SubSections tab, re-order 
the sub-Sections you created earlier. 

➢ Save and preview your changes. 
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 A Appendix A 

 
Make selected text Bold 

 
Insert a horizontal ruler 

 
Make selected text Italics 

 
Make selected text Subscript 

 
Text formatting styles (e.g.paragraph, 
heading 2)  

Make selected text Superscript 

 
Cut * 

 
Insert custom character (e.g. 
accented characters) 

 
Copy * 

 
Toggle full screen mode 

 
Paste * 

 
Edit HTML source 

 
Paste as plain text 

 
Insert link to a Section within SM 

 
Paste from Word (DO NOT USE THIS 
WHEN PASTING FROM WORD)  

Insert link to a specific content 
block within SM 

 
Select all 

 
Insert a link to a media item (e.g. 
image, PDF) in the SM Media 
Library 

 
Insert / edit hypertext link to an external 
web page  

Run the spell checker 

 
Unlink (remove link) 

 
Insert a new data table 

 
Find 

    
Edit table row properties 

 
Find and replace 

    
Edit table cell properties 

 
Format selected paragraphs as 
unordered (bullet) list      

 

Insert new table row above / below 

 
Format selected paragraphs as ordered 
(numbered) list     

Delete table row 

   
Outdent / Indent (use the latter to create 
sub-lists)      

 

Insert new column before / after 

 
Format paragraph as blockquote 

    
Delete column 

   
Undo / Redo previous actions 

    
Split merged table cells 

 
Format selected text as a Citation 

    
Merge selected table cells 

 
Format selected text as an Abbreviation   

 


